
HP ProLiant Essentials Rapid Deployment Pack—Windows Edition 
User Guide 

Part Number: 315378-009 

Ninth edition: January 2007 

Product version: 3.50 

 

 

 



2 
 
 

Legal notices 

© Copyright 2001–2007 Hewlett-Packard Development Company, L.P. 

Confidential computer software. Valid license from HP required for possession, use or copying. Consistent with FAR 12.211 and 12.212, 
Commercial Computer Software, Computer Software Documentation, and Technical Data for Commercial Items are licensed to the U.S. 
Government under vendor's standard commercial license. 

The information contained herein is subject to change without notice. The only warranties for HP products and services are set forth in the express 
warranty statements accompanying such products and services. Nothing herein should be construed as constituting an additional warranty. HP 
shall not be liable for technical or editorial errors or omissions contained herein. 

Microsoft and Windows are U.S. registered trademarks of Microsoft Corporation. Windows Server 2003 is a U.S. trademark or Microsoft 
Corporation. Intel is a trademark or registered trademark of Intel Corporation or its subsidiaries in the United States and other countries. 

Part Number: 315378-009 

Ninth edition: January 2007 

Product version: 3.50 

 



Contents 3  
 
 

Contents 

1  Configuring your system prior to deployment 
Configuring HP BladeSystem ..................................................................................................................... 4 
Configuring virtual machines ..................................................................................................................... 4 

VMware ESX Server virtual machine ...................................................................................................... 5 
Microsoft Virtual Server 2005 R2 virtual machine.................................................................................... 5 

Direct-attached storage environment deployments......................................................................................... 5 
Boot from SAN environment deployments.................................................................................................... 6 
SAN-attached environment deployments ..................................................................................................... 8 
Windows deployments ............................................................................................................................. 8 
Linux deployments.................................................................................................................................. 10 

Red Hat Enterprise Linux .................................................................................................................... 10 
VMware ESX Server deployments............................................................................................................. 10 

VMware ESX Server 2.5.3 ................................................................................................................. 10 
VMware ESX Server 3.0.1 ................................................................................................................. 11 

2  Using the Rapid Deployment Pack 
Connecting the server blades................................................................................................................... 12 
Creating a reference server and image..................................................................................................... 15 
Deploying the image to other similar server blades..................................................................................... 18 
Maintaining the servers with rip-and-replace.............................................................................................. 22 

3  Understanding the Deployment Server 
Jobs ..................................................................................................................................................... 23 
Job Default Settings ................................................................................................................................ 24 
How a Job is run on a target ................................................................................................................... 26 

Automation Environment .................................................................................................................... 27 
Deployment Server Directory Structure ...................................................................................................... 30 

4  Customizing the ProLiant and Integrity Integration Modules 
Preparing the Integration Modules for customization................................................................................... 31 

Jobs ................................................................................................................................................ 31 
Files ................................................................................................................................................ 31 

Reasons to customize the Integration Modules............................................................................................ 32 
All operating systems......................................................................................................................... 32 
Windows unattend text files................................................................................................................ 32 
Red Hat Linux kickstart files ................................................................................................................ 32 
SUSE Linux control files ...................................................................................................................... 32 
VMware ESX Server kickstart files........................................................................................................ 32 
Virtual Machine jobs ......................................................................................................................... 32 

Customization examples ......................................................................................................................... 33 
Example 1—Using a specific ProLiant Support Pack version.................................................................... 33 
Example 2—Modifying the Windows unattend text file .......................................................................... 33 
Example 3—Modifying the Red Hat Linux kickstart files.......................................................................... 33 
Example 4—Modifying the Altiris Deployment Agent for Linux ................................................................ 33 
Example 5—Creating a Create Virtual Machine job for other operating systems ....................................... 33 
Example 6—Modifying a Create Virtual Machine job for custom virtual values ......................................... 34 

5  HP support and contact information 
Related documents ................................................................................................................................. 35 
Online resources.................................................................................................................................... 35 
HP contact information ........................................................................................................................... 35 

Index 
 



 

Configuring your system prior to deployment 4  
 
 

1  Configuring your system prior to deployment 
The following sections detail the configuration steps necessary to deploy an operating system to a server, virtual 
machine, or specific platform.  

 IMPORTANT:  For your deployment, you might need to complete more than one of the procedures in this 
section. 
 

Deployment configuration information is provided for the following platforms and environments: 

• HP BladeSystem servers 
• Virtual machines 
• Direct-attached storage 
• Boot from storage area network (SAN) 
• SAN-attached storage 
Deployment configuration information is provided for the following operating system: 

• Microsoft® Windows® 
• Linux 
• VMware ESX Server 

Configuring HP BladeSystem 
The Physical Devices view in the Deployment Server Console displays the physical relationship between the racks, 
enclosures, and server blades using the rack name and enclosure name for each HP BladeSystem server. The display 
name for a new server blade is a combination of the rack name, enclosure name, and bay number. Before you 
connect the first server in an enclosure to the Deployment Server, assign the rack, and enclosure with unique names to 
prevent conflicting database entries. 

If the BladeSystem servers are powered up before the rack name and enclosure name have been changed, they are 
recorded in the Deployment Server database and displayed in the Deployment Server Console. If the names are 
changed after being recorded in the Deployment Server database, then the servers must be rebooted for the new rack 
name and enclosure name to be discovered. In addition, the original default names for the rack and enclosure must 
be manually deleted from the console. 

To change the rack name and enclosure name, follow the procedure specific to each server type: 

• ProLiant BL p-Class servers—Place at least one server blade in each enclosure, and before powering up the 
server blade, change the rack and enclosure information using the Integrated Lights-Out (iLO) interface. For 
details about accessing iLO to change the rack name and enclosure name, see the documentation shipped with 
your server blade. 

• HP BladeSystem c-Class servers—To access the Onboard Administrator and change rack name and enclosure 
name, see the server documentation. 

Configuring virtual machines  
The following configuration steps are required to support virtual-machine-scripted installations. 
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VMware ESX Server virtual machine 

 NOTE:  The following procedure is based on the assumption that VMware ESX Server has been initialized. For 
more information, see the “VMware ESX Server deployments” section in this guide. 
 

Create a new virtual machine to ensure that the guest operating system is appropriate for the operating system to be 
installed on the virtual machine. For more information about creating virtual machines, see the VMware 
documentation located at 
http://h18004.www1.hp.com/products/servers/software/vmware/index.html?jumpid=reg_R1002_USEN. 

Manually creating a virtual machine 
1. Power up the virtual machine. 
2. At the VMware Remote Console, press F2 to access the BIOS. 
3. Set the network adapter to be first in the boot order, enabling the virtual machine to Preboot eXecution 

Environment (PXE) boot during the scripted installations. 
4. Save the virtual machine BIOS settings and reboot the virtual machine. The virtual machine appears in the 

Deployment Server Console as a new computer. 

Using a job to create a virtual machine 
From the Deployment Server console, use the Virtual Machine Deployment Toolbox/1 – Create Virtual Machine jobs. 
This job will create the virtual machine, set the network adapter first in the boot order, and start the new virtual 
machine by booting to PXE. The new virtual machine will show up in the Deployment Server console in New 
Computers after the virtual machine has completed the boot process. 

Microsoft Virtual Server 2005 R2 virtual machine 
To create and power up a virtual machine: 
1. From the Virtual Server Remote Console, press Delete to access the BIOS. 
2. Set as first in the boot order the network adapter, enabling the virtual machine to PXE-boot during the 

scripted installations. 
3. Save the virtual machine BIOS settings, and reboot the virtual machine. The virtual machine appears in the 

Deployment Server Console as a new computer. 
For more information about creating virtual machines, see the Microsoft Virtual Server documentation located at 
http://www.microsoft.com/windowsserversystem/virtualserver/default.mspx.  

Direct-attached storage environment deployments 
For a scripted installation where an NTFS.IMG or GRUB.IMG file is deployed to initiate the operating system 
installation or for an image installation, the image file is deployed or captured to or from the drive according to the 
Altiris drive enumeration. If multiple storage drives are enabled on the target server, the job might install or capture 
the image on the secondary drives instead of the primary drives. The Read Hardware Configuration [server specific] 
job includes output from the Altiris showdisk utility. You can use this output to determine how the drives will be 
enumerated. This allows you to add the appropriate -d# parameters to the Create Disk Image or Distribute Disk Image 
task. For information on how to read data from the showdisk utility, see the Rapid Deployment Pack Knowledge Base 
at http://www.hp.com/servers/rdp/kb. 

 IMPORTANT:  If a USB device is used as the boot media method, a scripted installation or image installation 
job may deploy or capture the image to or from the USB device. The drive number of the hard drive must be 
specified for the Create Disk Image or Distribute Disk Image tasks. 

 

http://www.hp.com/servers/rdp/kb
http://h18004.www1.hp.com/products/servers/software/vmware/index.html?jumpid=reg_R1002_USEN
http://www.microsoft.com/windowsserversystem/virtualserver/default.mspx
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To specify which drive to use for installation: 

1. From the Deployment Server Console, copy, rename, and edit the job to be used for this deployment. 
2. Modify the Create Disk Image or Distribute Disk Image task. 
3. Select Advanced, and click the Additional Options tab. 
4. In the Additional command-line switches field, add the -dx switch, where x is an integer which represents the 

disk number of the first hard drive in the primary controller. 

 NOTE:  For step 4, refer to the Red Hat Enterprise Linux section for special use of –dx for deployments 
with LVM images. 

 

Boot from SAN environment deployments 
The following configuration steps are required before installing an operating system on a server with a QLogic or 
Emulex Fibre Channel Host Bus Adapter (FC HBA) that boots from an HP StorageWorks SAN. 

For details about SAN configurations and minimum firmware versions, see the following documents: 

• HP StorageWorks Booting Windows Systems from a Storage Area Network Application Notes 
• HP StorageWorks Booting Linux Systems from a Storage Area Network Application Notes 
1. Be sure the following prerequisites are met: 

• The target system is cabled in a single-path configuration (with only one channel active). You can cable 
both paths and zone only a single port to have access to the boot. Cabling both paths and only zoning a 
single port can be performed to have access to the boot logical unit number (LUN) until the server operating 
system install is complete and the multipathing software is installed. 

• The server has booted to PXE and is in a waiting state in the Deployment Server Console. 
2. Configure the SAN storage for the target system. 

a. Run the Read ProLiant ML/DL/BL HBA Configuration {LinuxPE} or {WinPE} job from the Server Deployment 
Toolbox\1—Hardware Configuration\HBA job folder on the target system. This job creates the 
.\lib\hwconfig\hba\ID.ini file, where ID is the target system computer ID. The following is an 
example of a generated file: 
[HBA0] 
WWID=500508b200713e72 
HostAdapterBiosEnable=1 
SelectBootEnable=1 
BootDeviceWWID= 
BootDeviceLUN= 

[HBA1] 
WWID=500508b200713e73 
HostAdapterBiosEnable=0 
SelectBootEnable=0 
BootDeviceWWID= 
BootDeviceLUN= 

 NOTE:  To determine the target system computer ID, right-click the target system and select Properties 
from the Deployment Server Console. Click the General tab. The computer ID appears in the ID field. 

 

b. Create a LUN for the boot volume of the target system. Record the created LUN and the World Wide 
Identification (WWID) of the boot controller. 

c. Using the target system HBA WWID from the file created in step 2a, configure the SAN switches for zoning 
or Selective Storage Presentation as needed in your environment. 

3. Configure the target system HBA to boot from the configured SAN storage. 
a. Edit the ID.ini file created in step 2a, adding the previously recorded boot controller WWID and LUN. 

The boot volume must be set up as the first visible LUN. The following is an example of an edited file: 
[HBA0] 
WWID=500508b200713e72 
HostAdapterBiosEnable=1 
SelectBootEnable=1 
BootDeviceWWID=395442c135713a41 
BootDeviceLUN=01 
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[HBA1] 
WWID=500508b200713e73 
HostAdapterBiosEnable=0 
SelectBootEnable=0 
BootDeviceWWID=395442c135713a42 
BootDeviceLUN=01 

b. Run the Write ProLiant ML/DL/BL HBA Configuration {LinuxPE} or {WinPE} job from the Server Deployment 
Toolbox\1—Hardware Configuration\HBA job folder on the target system. 

c. Run the Deploy ProLiant BL System Configuration (Boot From SAN) {LinuxPE} or {WinPE} job from the Server 
Deployment Toolbox\1—Hardware Configuration\System job folder on the target system. This job disables 
the embedded array controller and places the HBA controller first in the boot order. 

4. To deploy a Windows operating system, the system must be set up in a single-path configuration. To enable 
access to the LUN only from the first HBA and one array controller port, either set up only one path to the LUN 
or configure the SAN switch zoning to enable access to the LUN from only the first HBA and one array 
controller port. With two paths configured to the LUN (through both HBAs on a server blade, for example), a 
Windows setup failure message appears stating that a drive is unformatted, damaged, or formatted with a file 
system that is incompatible with Windows. 

5. To deploy the Red Hat Linux operating system when multiple LUNs are presented before the operating system 
installation, modify the job and kickstart file to place the operating system partitions on the first LUN. By default, 
the deployment installs Linux partitions across the available LUNs. If only one LUN is presented during the 
operating system installation, no changes to the kickstart file or job are necessary. 
a. On the Deployment Server, copy and rename the kickstart file. 
b. Modify the new kickstart file by replacing the autopart command with separate part command lines and 

adding the ---ondisk=XXX option to each, where XXX is the device label.  
For example for non-LVM: 

part /boot --size 75 --ondisk=sda 
part swap -–recommended --ondisk=sda 
part / --size 5120 -–grow --ondisk=sda 

For example for LVM: 

part /boot --size 75 --fstype=ext3 --asprimary --ondisk=sda 
part swap --recommended --asprimary --ondisk=sda 

part pv.01 --size=100 --grow --ondisk=sda 
volgroup myvgl pv.01 

logvol / --vgname=myvgl --size=100 --grow --name=rootvol 

c. In the Deployment Server Console, copy and rename the scripted install job. 
d. Edit the Run Script – Create Boot Environment task in the new job to use the new kickstart file created in step 

5a. 
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SAN-attached environment deployments 
The following configuration steps are required to deploy an operating system on a server with a QLogic or Emulex FC 
HBA attached to an HP StorageWorks SAN. 

For information about required firmware, drivers, and software for your SAN environment, see the HP StorageWorks 
SAN Design Reference Guide. 

1. Be sure the following prerequisites are met: 
• The target system HBA BIOS is disabled before performing a SAN-attached deployment so the target server 

will not attempt to boot to the HBA device. 
• The server has booted to PXE and is in a waiting state in the Deployment Server Console. 

If the LUNS is not present before the operating system is installed, no changes to the job is required.  

Steps 2 and 3 are only required if the LUNS is presented before the operating system is installed. The following job 
changes might be required. 

2. For a scripted installation, where an NTFS.IMG or GRUB.IMG file is deployed to initiate the operating system 
installation or for an image installation, the image file is deployed or captured to or from the drive according to 
the Altiris drive enumeration. Because the WinPE and Linux automation environments recognize the embedded 
drives and SAN controllers regardless of whether the HBA BIOS is disabled or enabled, the job might install or 
capture the image file to the SAN controller drives instead of the target server primary drives. The Read 
Hardware Configuration [server specific] job includes output from the Altiris showdisk utility. You can use this 
output to determine how the drives will be enumerated. This allows you to add the appropriate -d# parameter to 
the Create Disk Image or Distribute Disk Image task. For information on how to read data from the showdisk 
utility, see the Rapid Deployment Pack Knowledge Base at http://www.hp.com/servers/rdp/kb. 
To specify which drive to use for installation: 

a. From the Deployment Server Console, copy, rename, and edit the job to be used for this deployment. 
b. Modify the Create Disk Image or Distribute Disk Image task. 
c. Select Advanced, and click the Additional Options tab. 
d. In the Additional command-line switches field, add the -dx switch, where x is an integer representing the 

disk number of the first hard drive in the embedded controller. 

 NOTE:  For step 2 d, refer to the Red Hat Enterprise Linux section for special use of –dx for 
deployments with LVM images. 

 

3. For a scripted installation, to deploy the Red Hat Linux operating system, modify the job and kickstart file to 
ensure that the operating system partitions are installed on the target system hard drive. 
a. On the Deployment Server, copy and rename the kickstart file. 
b. Modify the new kickstart file by replacing the autopart command with separate part command lines and 

adding the ---ondisk=XXX option to each where XXX is the device label. 
For example for non-LVM: 

part /boot --size 75 --ondisk=cciss/c0d0 
part swap -–recommended --ondisk=cciss/c0d0 
part / --size 5120 -–grow --ondisk=cciss/c0d0 

For example for LVM: 

part /boot --size 75 --fstype=ext3 --asprimary --ondisk=cciss/c0d0 
part swap --recommended --asprimary --ondisk=cciss/c0d0 

part pv.01 --size=100 --grow --ondisk=cciss/c0d0 
volgroup myvgl pv.01 

logvol / --vgname=myvgl --size=100 --grow --name=rootvol 

c. In the Deployment Server Console, copy and rename the scripted install job. 
d. Edit the Run Script – Create Boot Environment task in the new job to use the new kickstart file created in step 

3a. 

Windows deployments 
Depending on your deployment needs, it might be necessary to perform the following configuration steps to support 
Windows scripted installation: 

http://www.hp.com/servers/rdp/kb
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1. Modify the Windows unattend text file located on the Deployment Server at .\lib\osconfig\yyyy, where yyyy is 
the Windows operating system shortcut name, with settings specific to your environment. Suggested settings to 
change are: 
• Domain 
• Administrator password 
• SNMP community string and trap destinations 
For more information about editing a Windows scripted installation unattend text file, see the Windows 2000 
online resource kit at http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp. 

2. Modify the Deployment Agent for Windows (AClient) settings by selecting Tools>Options from the Deployment 
Server Console. Click the Agent Settings tab, select Force new agents to take these default settings, and click 
Change Default Settings. HP recommends the following setting: 
a. Click the Startup/Shutdown tab, and select these options: 

• Force programs to close when shutting down 
• Synchronize date/time with the Deployment Server 

b. (Optional) If you need to change the settings for the AClient is installed, modify 
.\lib\osoem\altiris\aclient.txt. 

3. Modify the Microsoft Sysprep jobs located in the Server Deployment Toolbox 2C—OS Installation (Sysprep) 
folder, based on your image type. 
For each Capture Windows Sysprep Image job: 

a. Select the Create Disk Image task. 
b. Click Modify. 
c. In the Sysprep Settings field, select Add New from the Operating System dropdown list. 
d. In the OS Product Key field, select the appropriate operating system. 
e. Click Add to enter a new product key. 
f. Enter the product key in the Product Key field, and click OK>OK>Finish. 
For each Deploy Windows Sysprep Image job: 

a. Select the Distribute Disk Image task. 
b. Click Modify. 
c. In the Sysprep Settings field, select the appropriate operating system from the Operating System 

dropdown list. 
d. Select the appropriate product key from the Product key dropdown list, and click Finish. 

The following step must be performed before deploying each server: 

4. Before executing a Windows-scripted installation job, verify that the computer name in the Deployment Server 
Console is NETBIOS-compliant and that the right-most 15 characters are unique. Windows scripted installation 
jobs perform a token-replace of the computer name from the Deployment Server Console. The computer name is 
truncated to the right-most 15 characters and spaces are removed to comply with NETBIOS limitations. 

http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp
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Linux deployments 
Red Hat Enterprise Linux 

For imaging of a target with Red Hat Linux and LVM, the Distribute Disk Image task will need to be modified to 
indicate the first and last drive if the LVM volume spans multiple logical drives. The Read Hardware Configuration 
[server specific] job includes output from the Altiris showdisk utility. You can use this output to determine how the 
drives will be enumerated. This allows you to add the appropriate -d# parameter to the Distribute Disk Image task. 
For information on how to read data from the showdisk utility, see the Rapid Deployment Pack Knowledge Base at 
http://www.hp.com/servers/rdp/kb. 

To specify which drives to use for installation: 
1. From the Deployment Server Console, copy, rename, and edit the job to be used for this deployment. 
2. Modify the Distribute Disk Image task. 
3. Select Advanced, and click the Additional Options tab. 
4. In the Additional command-line switches field, add the –dy switch, where y is comma separated integers 

representing the disk numbers that the LVM volume will span. For example, to deploy an LVM image to two 
drives, use –d1,2. 

VMware ESX Server deployments 
The following configuration steps are required to support VMWare ESX Server deployments. The first procedure is 
specifically for ESX Server 2.5.3, and the second is for ESX Server 3.0.1. 

VMware ESX Server 2.5.3 
In a SAN-attached environment, you must copy and rename the scripted installation job before deploying VMware 
ESX Server 2.5.3. After renaming the scripted installation job, edit the Run Script – Create Boot Environment task in 
the new scripted installation job by changing the default.cfg file reference in the # replacetokens 
statement to sanattach.cfg. 

In a boot-from-SAN environment, you must copy and rename the scripted installation job before deploying VMware 
ESX Server 2.5.3. After renaming the scripted installation job, edit the Run Script – Create Boot Environment task in 
the new scripted installation job by entering export bootfromsan=yes before you enter 
/mnt/ds/lib/bin32/linux/vmesx.sh. 

Perform the following steps after the VMware ESX Server scripted installation is complete, but before setting up virtual 
machines and deploying operating systems to the virtual machines. These steps can also be used if the VMware ESX 
Server was installed using a method other than a Rapid Deployment Pack scripted installation. 

These post-deployment steps are performed manually. However, these steps can be automated during the scripted 
installation by modifying the kickstart files before deploying VMware ESX Server. For details, see the VMware 
documentation. 

 NOTE:  For details about accessing the VMware MUI, initializing VMware, and creating virtual machines, see 
the VMware documentation. 
 

After VMware ESX Server is installed on a server, browse to the VMware MUI at http://hostname or 
http://xxx.xxx.xxx.xxx, where hostname is the fully-qualified domain name or xxx.xxx.xxx.xxx is the IP address of 
the server on which VMware ESX Server is installed. 

 IMPORTANT:  If VMware was installed using a Rapid Deployment Pack scripted installation, the default root 
password is “password” for the MUI. 
 

1. For all servers, initialize VMware ESX Server.  
2. To launch the VMware ESX Server MUI for the first time: 

a. Select Options>Licensing and Serial Numbers. 
b. If you agree to the terms of the license agreement, click Agree. 
c. Enter the appropriate VMware serial numbers. 
d. Reboot the VMware ESX Server when prompted. 

3. Additionally, for SAN-attached environments the following VMware ESX Server MUI modifications are required. 
To create the core dump partition: 

a. Click Reconfigure when the following warning message appears: 

http://www.hp.com/servers/rdp/kb
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No core dump partition is configured or none is accessible 

b. Select the LUN on which to place the core dump partition. The core dump partition cannot be created on 
the local ATA drive. 

c. Set the desired size of the core dump partition. VMware recommends 100 MB for each VMware ESX 
Server. The partition size defaults to all remaining available LUN space. 

To create the Virtual Machine File System (VMFS): 

a. Select Storage Management. Available storage volumes and available space is displayed. The VMFS 
cannot be created on a local ATA drive. 

b. Select Create Volume/Name. 
c. Select Typical or Custom. A typical volume allocates all remaining space to the VMFS. 

VMware ESX Server 3.0.1 
The following steps must be completed before a VMware ESX Server 3.0.1 scripted installation is performed. 

1. For SAN-attached environments, you must disconnect the SAN. The SAN can be reconnected after the 
deployment is complete. 

2. Set the file transfer port on the Deployment Server. 
a. In the Deployment Server Console, select Tools>Options and click the Global tab. 
b. Select Client/server file transfer port, and enter 4300. 
c. Click OK. 

The following steps must be performed after the VMware ESX Server scripted installation is complete, but before 
setting up virtual machines and deploying operating systems to the virtual machines. These steps can also be used if 
the VMware ESX Server was already installed using a method other than an HP ProLiant Essentials Rapid Deployment 
Pack scripted installation. 

1. Enable VMware licensing: 
a. Install and launch the Virtual Infrastructure Client. 
b. Log in to the new VMware ESX Server. 
c. Click the Configuration tab, and click Licensed Features. 
d. Click License Sources>Edit. 
e. Select Use License Server or Use Host License File, and type the appropriate server address or local file path. 
f. Click ESX Server License Type>Edit, and select the appropriate license type. 
g. Select Add-Ons to install a Virtual Symmetric Multi-Processing (SMP) license if necessary. 

2. If using the SAN as a datastore, create a VMFS datastore on the SAN.  

 NOTE:  The VMware ESX Server scripted installation will create a local VMFS datastore called localvmfs. 
 

 NOTE:  The VMFS cannot be created on a local ATA drive. 

 

3. Shut down the VMware ESX Server, configure and connect the SAN, and restart the VMware ESX Server. 
a. From the Virtual Infrastructure Client, click Storage (SCSI, SAN, and NFS)>Add Storage. 
b. Configure the new datastore. 
c. Click Disk/LUN. 
d. Select the device to use for the datastore, such as a local drive or SAN LUN, and click Next. 
e. Select Use free space, and click Next. 
f. Enter a name for the datastore, and click Next. 
g. Click Next to accept the default maximum file size and capacity. 
h. Review the disk layout summary, and click Finish. 

The VMware ESX Create VMFS Datastore task begins. Task status appears in the Recent Tasks pane. When the task is 
complete, the new datastore is ready for use. 
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2 Using the Rapid Deployment Pack 
This section provides information about the following topics: 

• Connecting server blades 
• Creating a reference server and image 
• Deploying a captured image to other similar servers 
• Maintaining the servers with rip-and-replace 
Although the processes detailed in this section are for server blades, the process can be duplicated for other 
supported servers. To use these processes for other servers, the hardware configuration of the target systems must be 
identical to the hardware configuration of the reference server when performing the image-capture and deployment. 
Certain functionality is available only for server blades, which is noted where applicable in the following sections. 

The processes included in this section are based on the assumption that all necessary installation, post-installation, 
and predeployment configuration steps provided in this guide and the HP ProLiant Essentials Rapid Deployment 
Pack—Windows Edition Installation Guide have been performed. 

Connecting the server blades 
1. Connect the enclosure to the network that contains your Deployment Server, and power up the enclosure. 
2. Insert the server blades into the enclosure (do not power on the server blades).  
3. Change the default rack and enclosure names. 
4. Power up the server blades. 
5. Open the Deployment Server Console to view target servers available for deployment and management. The 

following panes appear in the console: 
• Computers—This pane is located on the upper-left side of the console and displays, by default, New 

Computers and All Computers. Virtual Machines and Physical Devices are also displayed (if enabled).  
• Jobs—This pane is located on the lower-left side of the console and lists the jobs provided with the Rapid 

Deployment Pack. 
• Details—This pane is located on the right side of the console and displays details for the selections 

highlighted within the Computers pane or the Jobs pane. 
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6. Select View>Show Physical Devices. 

 NOTE:  The Physical Devices view is an additional view available only for BladeSystem servers in the 
Computers pane. A job can be executed on a server listed in this view. 

 

 
Table 1 lists the server icons displayed in the Physical Devices view of the Deployment Server Console. 

Table 1  Server icons 

Icon Description 

 Indicates a grouping of physical devices  

 
Indicates a rack 

 
Indicates an enclosure 

 
Indicates a single server blade in a bay 

 Indicates an unconfigured server blade in a waiting state designated by the user 

 Indicates a virtual bay 

 

After the server blades PXE-boot, the servers appear in the Deployment Server Console under New Computers 
and Physical Devices. 

7. From the Computers pane, right-click the first server blade. 
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8. Select Power Control>RILOE/iLO – Interface. This action accesses the iLO, iLO 2, or RILOE interface to enable 
remote viewing of the deployment. 
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Creating a reference server and image 
The initial server blade must be deployed using a scripted installation job. Subsequent server blades are deployed by 
capturing and deploying the image of the initial server blade. You can deploy all of the server blades using a 
scripted installation, but the operating system installation is slower than when using an image installation. 

To create a reference server and image: 

1. In the Jobs pane, select a Windows-scripted installation job in the Server Deployment folder. Drag the job onto 
the first server blade in the Computers pane. 
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2. Select Run this job immediately, and click OK. 

 
The Details pane displays the job currently running. Double-clicking the job in the Details pane shows the tasks 
and status. When the server deployment is complete, the server icon changes. The image-capture job runs 
immediately after the current job is completed. 

 NOTE:  The Windows-scripted installations perform a token-replace of the computer name from the 
Deployment Server Console name. This computer name is truncated to the right-most 15 characters to 
comply with the NETBIOS limitation. The Linux- and VMware-scripted installs use the Deployment Server 
Console display name as the server host name. 
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3. In the Jobs pane, find the Read ProLiant ML/DL/BL System and Array Configuration and Windows 
Image {WinPE} job in the Server Replication folder. Drag the job onto the initial server blade in the Computers 
pane. 

 IMPORTANT:  The Server Replication jobs provided with the Rapid Deployment Pack create and deploy 
images using an image name based on the computer model names. If you use the provided jobs without 
modification, each time you capture a new image on the same computer model, the previous image is 
overwritten. For information about job setup and image file location on the Deployment Server, see the 
“Understanding the Deployment Server” section in this guide. 

 

 
4. Select Run this job immediately, and click OK. 
5. If the scripted installation job is still running on the server, click OK when the following warning message 

appears: 

 
The server reboots and performs the specified tasks. When the image capture is complete, the server icon changes to 
indicate that the server is connected to the Deployment Server. 
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Deploying the image to other similar server blades 
1. In the Computers pane, select all the server blades. Drag the server blades onto the Write ProLiant ML/DL/BL 

System and Array Configuration and Windows Image {WinPE} job in the Server Replication folder in the Jobs 
pane. 
If you are deploying the image to all server blades in an enclosure, you can select the enclosure from the 
Physical Devices view. Redeploying the captured image to the same reference server enables you to take 
advantage of the speed of image installations if the reference server is ever replaced with rip-and-replace 
enabled. 

 
2. Select Run this job immediately, and click OK. When the server deployment is complete, the server icons 

change to indicate the servers are connected to the Deployment Server. 
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3. To reconfigure the server blades after image deployment, in the Computers pane, select all the server blades, 
and then right-click the selection, and select Configure. 

 
4. Click Microsoft Networking, and then enter a new workgroup/domain name (if applicable) and click Define 

Range. 
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5. Enter the fixed portion of the new server names, and click OK. 

 
6. Click TCP/IP, and enter the IP information for the first server blade. Click OK. Subsequent server blades are 

assigned the same information, except that the IP address increases incrementally for each server blade. 
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7. Select Run this job immediately, and click OK to start the reconfiguration deployment. When the reconfiguration 
deployment is complete, the computer names are changed in the Deployment Server Console. 
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Maintaining the servers with rip-and-replace 
When a failed server blade is replaced, the Deployment Server Console can automatically replay the job history of 
the failed server blade on the new server blade. This feature is available only for BladeSystem servers. 

 IMPORTANT:  The new server blade requires a new license. The existing license cannot be transferred to the 
new server blade. 
 

To enable rip-and-replace, perform the following steps for each server blade: 

1. In the Computers pane, right-click a single server and select Properties. 
2. Scroll down and click Bay. 
3. Select Re-Deploy Computer from the Server change rule list. 

 
4. Click OK. 
The following server change rule options are available: 

• Re-Deploy Computer—Takes the job history of the previous server blade and replays it on the new server blade. 
The replay starts from the last deployment type job. This option is available only after the server blade is 
deployed or a virtual bay has been created. 

• Run Predefined Job—Processes any job specified by the user, including the Initial Deployment job. 
• Wait for User Interaction—Performs no job. The Deployment Agent on the server blade is instructed to wait and 

the icon in the console is changed to reflect a waiting server. 
• Ignore the Change—Ignores the new server blade, meaning that no jobs are initiated. If the new server blade 

existed in a previous bay, the history and parameters for the server are moved or associated with the new bay. 
If the server blade is not listed in the database, its properties are associated with the bay, and the normal 
process defined for new servers (if any) is followed. 
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3 Understanding the Deployment Server 
The Rapid Deployment Pack populates the Deployment Server Console with jobs and the Deployment Server directory 
with tools, scripts, configuration files, software drivers, and documentation files. This section explains these provided 
jobs and files, and the directory structure. For more information on how a job is executed on a target server, see the 
“Automation Environment” section in this guide. 

Jobs 
The Rapid Deployment Packs adds 4 root folders into the Jobs pane.  

   

Table 2  Job Folders 

Folder Description 

Server Deployment The jobs in this folder perform a complete server deployment. They deploy a default 
hardware configuration, execute a scripted operating system installation, and install the 
appropriate ProLiant or Integrity Support Pack. 

Server Deployment Toolbox The jobs in this folder provide more granular control over the server deployment process. By 
providing jobs that perform only hardware configuration, operating system installation, and 
value-add software installation, you can easily combine various jobs together to suit your 
needs. 

Server Replication The jobs in this folder perform replication from a reference server to a target system that is of 
the same server model with the same hardware configuration. 

Virtual Machine Deployment 
Toolbox 

The jobs in this folder provide the ability to create an VMware ESX virtual machine and to 
deploy an operating system to a virtual machine. 
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Job Default Settings 
Unless otherwise indicated in the job name, the job uses the following default settings. For details about how to 
customize these default settings, see the “Customizing the ProLiant and Integrity Integration Modules” section in this 
guide. 

Hardware configuration settings 

Table 3  Hardware default settings 

Component Default setting 

System ROM Factory defaults. 

Smart Array Based on the number of attached drives. 

iLO Not configured in the standard jobs. 

SAN HBA Not configured in the standard jobs. 
 

Operating system scripted install settings 
The provided Windows scripted install jobs use the default configuration parameters listed in Table 4  Windows 
default settings. 

Table 4  Windows default settings 

Component Default setting 

Windows administrator 
password 

The administrator password is password. This password is stored as clear text in the 
unattend answer file. HP recommends changing the default administrator password within 
the unattend answer file located in the .\lib\osconfig\yyyy directory in the Deployment 
Server default installation directory, where yyyy is the operating system shortcut name. 

Drive configuration A single partition is created automatically that expands to the full drive size. 

Computer name The Windows computer name uses the 15 right-most characters of the display name shown 
in the Deployment Server Console. 

 

The provided VMware scripted install jobs use the default configuration parameters listed in Table 5  VMware default 
settings. 

Table 5  VMware default settings 

Component Default setting 

VMware root password The root password is password. This password is stored as clear text in the kickstart file. 
HP recommends that you change the root password to your own password and in 
encrypted form within the kickstart file. 

Drive configuration When configuring the disk partition for a scripted operating system installation, various 
VMware ESX Server specific partitions are created. These are the default settings and 
must not be changed. 

Host name The VMware ESX Server host name uses the display name that appears in the 
Deployment Server Console. 

Packages VMware ESX Server specific packages are installed. Do not change this setting. 

Firewall Firewall settings are disabled. 
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The provided Red Hat Linux and SUSE Linux scripted install jobs use the default configuration parameters listed in 
Table 6  Linux default settings. 

Table 6  Linux default settings 

Component Default setting 

Linux root password The root password is password. This password is stored as clear text in the kickstart/control 
file. HP recommends that you change the root password to your own password and in encrypted form 
within the kickstart/control file. For information about editing the kickstart files, see the Red Hat Linux 
Customization Guide located at http://www.redhat.com. 
For SUSE instructions, see the AutoYast2 documentation located in the 
/usr/share/doc/packages/autoyast2/html/ directory after installing the AutoYast2 
package. 

Drive configuration The disk space is partitioned according to Red Hat or SUSE Linux default specifications. Red Hat 
Enterprise Linux 4 installs Logical Volume Manager (LVM) by default. 

Host name The Linux host name uses the display name that appears in the Deployment Server Console. 

Packages Basic Linux server packages are installed. The GNOME and KDE packages are not installed. For 
SUSE, the GCC compiler and kernel source packages are also installed. 

Firewall Firewall settings are disabled. 

Linux root password The root password is password. This password is stored as clear text in the kickstart/control 
file. HP recommends that you change the root password to your own password and in encrypted form 
within the kickstart/control file. For information about editing the kickstart files, see the Red Hat Linux 
Customization Guide located at http://www.redhat.com. 
For SUSE instructions, see the AutoYast2 documentation located in the 
/usr/share/doc/packages/autoyast2/html/ directory after installing the AutoYast2 
package. 

 

Read/Write job filenames 
The provided Read (Capture)/Write jobs use the default input/output filenames listed in Table 7  Default Read/Write 
jobs. 

Table 7  Default Read/Write jobs 

Read(Capture)/Write Job Pair Filename 

Server Deployment Toolbox > 1 – Hardware Configuration 

ProLiant ML/DL/BL System Configuration .\lib\hwconfig\system\pl-capture.xml 

ProLiant ML/DL/BL Array Configuration .\lib\hwconfig\array\pl-capture.ini 

ProLiant ML/DL/BL HBA Configuration [server specific] .\lib\hwconfig\hba\ID.ini where ID is the server ID number as 
given by Deployment Server 

Integrity RX/BL System Configuration .\lib\hwconfig\system\i-capture.xml 

Integrity RX/BL Array Configuration .\lib\hwconfig\array\i-capture.ini 

Server Deployment Toolbox > 2A – OS Installation (Imaged) 

Windows Image .\lib\images\capture-windows.img 

Linux Image .\lib\images\capture-linux.img 

Server Deployment Toolbox > 2C – OS Installation (SysPrep) 

Windows xxxx Sysprep Image .\lib\images\xxxx-sysprep.img where xxxx is the operating 
system name and shortcut name 

Server Replication 

ProLiant ML/DL/BL System and Array Configuration and 
Windows Image 

.\lib\hwconfig\system\yyyy-windows.xml 

.\lib\hwconfig\array\yyyy-windows.ini 

.\lib\images\yyyy-windows.img 
Where yyyy is the computer model name, for example bl20p 
g2. 

http://www.redhat.com/
http://www.redhat.com/


 

Understanding the Deployment Server 26  
 
 

Table 7  Default Read/Write jobs 

Read(Capture)/Write Job Pair Filename 

ProLiant ML/DL/BL System and Array Configuration and Linux 
Image 

.\lib\hwconfig\system\yyyy-linux.xml 

.\lib\hwconfig\array\yyyy-linux.ini 

.\lib\images\yyyy-linux.img 
Where yyyy is the computer model name, for example bl20p 
g2. 

Integrity RX/BL System and Array Configuration and Linux Image .\lib\hwconfig\system\yyyy-linux.xml 
.\lib\hwconfig\array\yyyy-linux.ini 
.\lib\images\yyyy-linux.img 
Where yyyy is the computer model name, for example bl20p 
g2. 

 

How a Job is run on a target 
This section provides a walkthrough of how a job is executed on a target server. The table within each step lists the 
state of the target server and the job action during that execution step. 

The terminology, automation environment, is used throughout this section. It is an operating system in which scripts 
can be run on the target independent of the target’s production operating system or the Deployment Server operating 
system. The target can boot the automation environment either from a CD-ROM, USB key, or through PXE. The Rapid 
Deployment Packs supports two automation environments: Linux x86 and ia64 (hereafter LinuxPE) and WinPE 1.6 
x86 and x64. Each automation environment consists of the necessary base files, additional HP drivers, and the 
appropriate Altiris Deployment Agent. 

 IMPORTANT:  A CD-ROM or USB key can only hold one automation environment. Many of the jobs use 
multiple automation environments. This means that as the job progresses, the boot media must be swapped 
accordingly. 
 

The Run Script, Create Disk Image, and Distribute Disk Image tasks allow the user to specify which automation 
environment to run in. The Rapid Deployment Pack jobs specify a specific automation environment to avoid ambiguity 
and to ensure that the utilities run in the correct and tested environment. 
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Automation Environment 
1. Power up the bare-metal target server. Since the target does not have a bootable hard drive, the boot order 

attempts a PXE boot. The PXE Server sends it the Initial Deploy boot option image. By default, this is Linux 
Managed (auto-select). The Deployment Agent connects to the Deployment Server. Since this is the initial 
connection and no pending job exists, the Deployment Server tells the Deployment Agent to wait. 

Table 8  Step 1 

Target Server LinuxPE, waiting 
 

2. Schedule the "Deploy ProLiant ML/DL/BL + Windows 2003 x64 Enterprise + PSP" job on the target. 

Table 9  Step 2 

Target Server LinuxPE, waiting 

Job Task 1 – Deploy System Configuration {WinPE 32-bit}, pending 
 

3. The Deployment Server determines that the target is in the incorrect automation environment. It tells the 
Deployment Agent to set the one-time boot EV to PXE and then reboot. When the targets reboots to PXE, the PXE 
Server sends it the WinPE 32-bit image. 

Table 10  Step 3 

Target Server rebooting to WinPE Managed 32-bit 

Job Task 1 – Deploy System Configuration {WinPE 32-bit}, pending 
 

4. When the Deployment Agent connects to the Deployment Server, the first task of the job begins to execute. 

Table 11  Step 4 

Target Server WinPE Managed 32-bit, executing task 

Job Task 1 – Deploy System Configuration {WinPE 32-bit} 
set inputfile=pl.xml 
call %altiris_share%\lib\bin32\winpe\conrep.cmd –l %inputfile% 

 

5. The second task in the job is a Reboot. By looking ahead at the third task, the Deployment Server tells the 
Deployment Agent to set the One-Time Boot EV to PXE and then reboot. When the targets reboots to PXE, the 
PXE Server sends it the WinPE Managed 32-bit image. 

This reboot is necessary in case any Smart Array controllers are disabled in the conrep file. 

Table 12  Step 5 

Target Server rebooting to WinPE 32-bit 

Job Task 2 – Reboot 
 

6. When the Deployment Agent connects to the Deployment Server, the third task of the job begins to execute. 

Table 13  Step 6 

Target Server WinPE 32-bit, executing task 

Job Task 3 – Deploy Array Configuration {WinPE 32-bit} 
set inputfile=pl-acu--d.ini 
call %altiris_share%\lib\bin32\winpe\acu.cmd –I %inputfile% 
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7. The fourth task in the job is a Reboot. By looking ahead at the fifth task, the Deployment Server tells the 
Deployment Agent to set the One-Time Boot EV to PXE and then reboot. When the targets reboots to PXE, the 
PXE Server sends it the WinPE Managed 32-bit image. 

This reboot is mandatory so that the subsequent imaging task is able to see the new hard drive. 

Table 14  Step 7 

Target Server rebooting to WinPE 32-bit 

Job Task 4 – Reboot 
 

8. When the Deployment Agent connects to the Deployment Server, the fifth task of the job begins to execute. 

Table 15  Step 8 

Target Server WinPE 32-bit, executing task 

Job Task 5 – Deploy System Configuration {WinPE 32-bit} 
set inputfile=pl-win.xml 
call %altiris_share%\lib\bin32\winpe\conrep.cmd –l %inputfile% 

 

9. The Deployment Agent begins executing the sixth task of the job. 

Table 16  Step 9 

Target Server WinPE 32-bit, executing task 

Job Task 6 – Distribute Disk Image {WinPE 32-bit} 
.\lib\images\NTFS.IMG 

 

10. The seventh task in the job is a Reboot. By looking ahead at the eighth task, the Deployment Server tells the 
Deployment Agent to set the one-time boot EV to PXE and then reboot. When the targets reboots to PXE, the PXE 
Server sends it the WinPE 64-bit image. 

This reboot is mandatory so that the subsequent file copy tasks are able to use the new hard drive. 

Table 17  Step 10 

Target Server rebooting to WinPE 64-bit 

Job Task 7 – Reboot 
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11. When the Deployment Agent connects to the Deployment Server, the eighth task of the job begins to execute. 
Since tasks eight through twelve all run in WinPE 64-bit and there is no Reboot task, they execute sequentially 
while in WinPE 64-bit. 

Table 18  Task 11 

Target Server WinPE 64-bit, executing tasks 

Task 8 – Copy ProLiant Files {WinPE 64-bit} 
set oem=proliant.zzz\w52.64 
call %altiris_share%\lib\bin64\winpe\osoem1.cmd 

Task 9 – Copy Altiris Files {WinPE 64-bit} 
rem replacetokens .\lib\osoem\altiris\aclient.txt .\lib\osoem\altiris\%ID%.inp 
set configfile=%ID%.inp 
call %altiris_share%\lib\bin64\winpe\osoem2.cmd 

Task 10 – Copy Unattend.txt {WinPE 64-bit} 
rem replacetokens .\lib\osconfig\w52e.64\default.txt .\lib\osconfig\w52e.64\%ID%.txt 
set unattendfile=w52e.64\%ID%.txt 
call %ALTIRIS_SHARE%\lib\bin64\winpe\osconfig1.cmd 

Task 11 – Copy Distribution Files {WinPE 64-bit} 
set dist=w52e.64 
call %altiris_share%\lib\bin64\winpe\osdist1.cmd 

Job 

Task 12 – Start Install {WinPE 64-bit} 
set HD=c 
for %%i in (c d e f g h i j k l m) do if exist %%i:\rdpimage set HD=%%i 
%HD%:\amd64\winnt32.exe /s:%HD%:\amd64 /unattend:%HD%:\unattend.txt /syspart:%HD%: 
/tempdrive:%HD%: 

 

12. After completing the twelfth task, the Deployment Server looks ahead at the thirteenth task. That task runs in 
production Windows. Therefore, the Deployment Server tells the Deployment Agent to reboot. When the target 
reboots, it boots to the hard drive since the hard drive is bootable and before PXE in the default boot order. 

Table 19  Step 12 

Target Server executing Windows scripted install 

Job Task 13 – Install Package {Windows}, pending 

 

13. The Deployment Agent for Windows is installed as part of the Windows scripted install. The Deployment Agent 
loads upon the first real Windows production boot. When it connects to the Deployment Server, the thirteenth 
task of the job begins to execute. 

Table 20  Step 13 

Target Server Windows, executing task 

Job Task 13 – Install Package {Windows} 
.\lib\software\ProLiant Support Pack Z.ZZ for Windows 2003 x64\setupex.exe 
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14. The last task in the job is a Reboot. The Deployment Server tells the Deployment Agent to reboot. 
This reboot is mandatory so that the new and updated drivers installed by the ProLiant Support Pack get loaded 
properly. 

Table 21  Step  14 

Target Server rebooting to Windows 

Job Task 14 – Reboot 
 

Deployment Server Directory Structure 
The following table provides an overview of the Deployment Server directory as populated by the Rapid Deployment 
Pack. 

Table 22  Deployment Server directory structure 

Directory Description 

.\docs • Rapid Deployment Pack and SmartStart Scripting Toolkit documentation in Portable Document 
Format (.pdf) 

.\jobs • The .bin files for the provided jobs 

.\lib\bin32 • Various Windows x86 and Linux x86 tools and scripts 
• Windows SmartStart Scripting Toolkit 
• Linux SmartStart Scripting Toolkit 

.\lib\bin64 • Various Windows x64 tools and scripts 

.\lib\binia64 • Various Windows ia64 and Linux ia64 tools and scripts 
• Smart Setup Scripting Toolkit for Integrity 

.\lib\hwconfig • Presupplied and captured hardware configuration files. 

.\lib\images • Presupplied and captured image files. 

.\lib\osconfig • Operating system scripted install answer files separated into subdirectories per OS. 

.\lib\osdist • Operating system distribution files separated into subdirectories per OS. Each subdirectory contains 
the entire contents of the source DVD or CD-ROM(s). 

.\lib\osoem • ProLiant Drivers for Windows Scripted Installs 
• Altiris Deployment Agents 
• Integrity Support Packs 
• The proliant.xxx or integrity.xxx subdirectories are either a specific version number, such as 7.70 

or Z.ZZwhich is a copy of the latest version subfolder. The Z.ZZ  subfolder is used by the provided 
scripted install jobs. 

.\lib\ossysprep • Operating system sysprep imaging answer files. 

.\lib\software • ProLiant Support Packs 
• ProLiant Firmware Updates 
• Integrity Support Packs 
• The Support Pack x.xx subdirectories are either a specific version number, such as 7.70, or Z.ZZ, 

which is a copy of the latest version subfolder. The Z.ZZ subfolder is used by the provided scripted 
install jobs.  
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4 Customizing the ProLiant and Integrity Integration 
Modules 

Preparing the Integration Modules for customization 
Before modifying the provided jobs, folders, and files, make a copy of the job, files, or both and use this copy for 
your custom work. Keeping the original job and files ensures that a working version exists. If you encounter a 
problem or if you select to overwrite the jobs or files during an upgrade or reinstallation of the Rapid Deployment 
Pack, your customized job or file is not overwritten. 

Jobs 
This section explains how to copy, paste, rename, and edit a job in the Deployment Server Console Jobs pane. For 
additional information about the customization features of the Deployment Server Console, see the Altiris Deployment 
Solution 6.8 Deployment and Migration Guide at http://www.hp.com/servers/rdp. 

To copy, paste, rename, and edit a job: 

1. Right-click the job and select Copy. 
2. Right-click another location in the Jobs pane, and select Paste. 

 IMPORTANT:  The jobs in the Rapid Deployment Pack use long names to be descriptive. When attempting 
to copy these jobs to the same directory as the original job, the name might be truncated by Altiris 
because it places the text “Copy of” in front of the job causing it to exceed the 128-character limit of the 
Deployment Server Console. 

 

3. Right-click the new job, select Rename, or select the new job and press F2. 
4. Enter a descriptive name for the job, and press Enter. 
5. Press Enter. 
6. Select the new job. 
7. In the Details pane, double-click a task to edit its contents. 
Export or import a job from a file as a method of backing up a job or a job folder. To export a job or folder: 

1. Right-click the job or folder. 
2. Select Export. 
3. In the Export Selected Job(s)/Folder(s) dialog box, click Browse to designate a directory and job file, or enter 

the path and file name in the Export to File Name field. Select Export subfolders if you want to export the 
subfolders of a folder. 

 NOTE:  Job files are usually denoted with the .bin extension. 
 

4. Click OK. 
To import a job or folder: 

1. Right-click within the Jobs pane. 
2. Select Import. 
3. In the Import Job dialog box, click Browse to locate the directory and job file, or enter the path and file name in 

the Job file to import field. Job files are usually denoted with the .bin extension. 
4. Select the appropriate checkboxes, and then click OK. 

Files 
On the Deployment Server, copy, paste, rename, and edit the file using the appropriate operating system commands. 
After the new file is created, modify the job as described in the previous section to use the new file name. 

 IMPORTANT:  If editing Linux or VMware ESX files on the Deployment Server, a text editor must be used that 
saves the file in Linux format without adding extra characters. 
 

http://www.hp.com/servers/rdp
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Reasons to customize the Integration Modules 
The following sections provide information about why you might want to customize the ProLiant Integration Module or 
Integrity Integration Module. For additional information about customizing your installations, see the Rapid 
Deployment Pack Knowledge Base at http://www.hp.com/servers/rdp/kb. 

All operating systems 
You might want to customize the provided unattend text files to perform the following tasks: 

• Change the array configuration 
• Use a specific version of ProLiant Support Pack or Integrity Support Pack 
• Modify the Altiris Deployment Agent settings (aclient or adlagent) 

Windows unattend text files 
You might want to customize the provided unattend text files to perform the following tasks: 

• Specify the SNMP community string and trap destinations 
• Change the administrator password 
• Specify a domain 
For more information about editing a Windows-scripted installation unattend text file, see the Windows 2000 Online 
Resource Kit at http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp. 

Red Hat Linux kickstart files 
You might want to customize the provided kickstart files to perform the following tasks: 

• Change the default root password 
• Add a grub bootloader password 
• Change the partitions, types, and sizes 
• Change the Linux packages that are installed 
• Change the firewall settings 
• Add additional post installation commands 
For information about editing the kickstart files, see the Red Hat Linux Customization Guide located at 
http://www.redhat.com. 

SUSE Linux control files 
You might want to customize the provided control files to perform the following tasks: 

• Change the default root password 
• Add a grub bootloader password 
• Change the partitions, types, and sizes 
• Change the Linux packages that are installed 
• Change the firewall settings 
• Add additional post install commands 
For more information about editing the control files, see the AutoYast2 documentation located in the 
/usr/share/doc/packages/autoyast2/html/ directory after installing the AutoYast2 package. 

VMware ESX Server kickstart files 
You might want to customize the provided kickstart files to change the default root password. 

HP recommends that you do not modify the VMware ESX Server kickstart file with other modifications. For supported 
VMware kickstart options, see http://www.vmware.com. 

Virtual Machine jobs 
You might want to customize the provided virtual machine jobs to perform the following tasks: 

• Create a Create Virtual Machine job for another operating system 
• Change the virtual disk size 
• Change the virtual memory size 

http://www.hp.com/servers/rdp/kb
http://www.microsoft.com./windows2000/techinfo/reskit/en-us/default.asp
http://www.redhat.com/
http://www.vmware.com/
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For more information, see the VMware Virtual Infrastructure SDK Reference Guide at 
https://www.vmware.com/pdf/SDKReferenceGuide.pdf. 

Customization examples 
This section provides specific examples of modifying a few of the ProLiant Integration Module components. To make 
copies of the jobs and files, see the “Preparing the Integration Modules for customization” section in this guide. For 
information about job structure and file locations, see the “Understanding the Deployment Server” section in this 
guide. 

Example 1—Using a specific ProLiant Support Pack version 
For a specific operating system, you might want to use a newer ProLiant Support Pack version that was downloaded 
from the Web and is supported by the current operating system versions, or an older version that was previously 
installed before a Rapid Deployment Pack upgrade. 

To change to a specific ProLiant Support Pack version: 

1. If downloading a new ProLiant Support Pack version, perform the following steps on the Deployment Server: 
a. Create the appropriate .\lib\software\ProLiant Support Pack yyyy directory, where yyyy is the operating 

system name and support pack version. Copy support pack files to this location. 
b. For Linux or VMware versions, copy the Rapid Deployment Pack ProLiant Support Pack installation files, 

rdpinstall.sh and rdpinstall.dat, from a similar operating system version to this directory. 
2. After creating a copy of the job, perform one of the following tasks: 

• For Windows, edit the Install Package task to install the files from the chosen directory. 
• For VMware or Linux, edit the Copy File to task to copy the files from the chosen directory. 

Example 2—Modifying the Windows unattend text file 
The Windows unattend text files have many components that can be customized for a Windows-scripted installation. 
To change a Windows unattend text file: 

1. On the Deployment Server, modify the copy of the unattend text file for your operating system version. 
2. After creating a copy of the job, edit the Run Script - Create Boot Environment task in this job and the rem 

replacetokens line to use this new unattend text file. 

Example 3—Modifying the Red Hat Linux kickstart files 
The Red Hat Linux kickstart files have several components that can be customized for a Linux-scripted installation. To 
change a Red Hat Linux kickstart file: 

1. On the Deployment server, modify the copy of the kickstart file for your distribution version. 
2. After creating a copy of the job, edit the Run Script - Create Boot Environment task in this job and the set 

unattendfile= line to use this new kickstart file. 

Example 4—Modifying the Altiris Deployment Agent for Linux 
The Altiris Deployment Agent for Linux, adlagent, uses an adlagent configuration file adlagent.conf, to read its 
settings. This file can be modified and then deployed during the Linux installation for adlagent to read at startup. All 
Linux deployments use this custom adlagent configuration file. To change the adlagent settings: 

1. Using an adlagent.conf file from a working target, modify the file for your specific settings. 
2. Name this file adlagent.conf.custom, and place this file on the Deployment Server in the 

.\lib\osoem\altiris directory. 

Example 5—Creating a Create Virtual Machine job for other operating systems 
The Virtual Machine Deployment Toolbox / 1- Create Virtual Machine folder provides a few virtual machine creation 
jobs for specific operating systems. These jobs can be copied and used to create virtual machines on other operating 
systems. To create a Virtual Machine job: 

1. In the Deployment Server Console, copy and rename a Create Virtual Machine job. 
2. Edit the new job and the Run Script – Create Virtual Machine task, changing the VMOS= value to a new value 

representing the target operating system. Some possible values are listed in the comments of this task. For more 
information, see the VMware Virtual Infrastructure SDK Reference Guide at 
https://www.vmware.com/pdf/SDKReferenceGuide.pdf. 

https://www.vmware.com/pdf/SDKReferenceGuide.pdf
https://www.vmware.com/pdf/SDKReferenceGuide.pdf
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Example 6—Modifying a Create Virtual Machine job for custom virtual values 
To change the Create Virtual Machine job to use different virtual-disk-size or virtual-memory-size values: 

1. In the Deployment Server Console, copy and rename a Create Virtual Machine job. 
2. Edit the new job and the Run Script – Create Virtual Machine task, changing the VMDISKSIZE= and/or 

VMMEMSIZE= values to new values. Some possible values are listed in the comments of this task. For more 
information, see the VMware Virtual Infrastructure SDK Reference Guide at 
https://www.vmware.com/pdf/SDKReferenceGuide.pdf. 

https://www.vmware.com/pdf/SDKReferenceGuide.pdf
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5 HP support and contact information 

Related documents 
HP recommends reviewing the following documentation before reading this guide: 

• HP ProLiant Essentials Rapid Deployment Pack Planning Guide 
• HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Release Notes 
• HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Support Matrix 
• HP ProLiant Essentials Rapid Deployment Pack—Windows Edition Installation Guide 
All of the documents can be found in PDF format at http://www.hp.com/servers/rdp, from the Rapid Deployment 
Pack DVD autorun utility, at \docs on the product DVD, and at .\docs on the Deployment Server. 

Online resources 
• Information about the Rapid Deployment Pack and the latest updates are available from the HP ProLiant 

Essentials Rapid Deployment Pack website at http://www.hp.com/servers/rdp. 
• Regularly updated troubleshooting information, frequently asked questions, and specific how-to procedures are 

available at the HP ProLiant Essentials Rapid Deployment Pack Knowledge Base at 
http://www.hp.com/servers/rdp/kb. 

• Problem-solving information and ideas from other IT professions are available in the IT Resource Center (ITRC) 
User Forum “ProLiant Deployment & Provisioning.” This forum is accessible from the Management Software and 
System Tools link at http://forums.itrc.hp.com. 

• Information and resources about the Altiris Deployment Solution is available from the Altiris website at 
http://www.altiris.com. 

HP contact information 
For the name of the nearest HP authorized reseller: 

• In the United States, see the HP U.S. service locator webpage at http://www.hp.com/service_locator. 
• In other locations, see the Contact HP worldwide webpage at 

http://welcome.hp.com/country/us/en/wwcontact.html. 
For HP technical support: 

• In the United States, for contact options see the Contact HP United States webpage at 
http://welcome.hp.com/country/us/en/contact_us.html. To contact HP by phone: 
• Call 1-800-HP-INVENT (1-800-474-6836). This service is available 24 hours a day, 7 days a week. For 

continuous quality improvement, calls may be recorded or monitored. 
• If you have purchased a Care Pack (service upgrade), call 1-800-633-3600. For more information about 

Care Packs, see the HP website at http://www.hp.com. 
• In other locations, see the Contact HP worldwide webpage at 

http://welcome.hp.com/country/us/en/wwcontact.html. 
 

http://www.hp.com/servers/rdp
http://www.hp.com/servers/rdp
http://www.hp.com/servers/rdp/kb
http://forums.itrc.hp.com/
http://www.altiris.com/
http://www.hp.com/service_locator
http://welcome.hp.com/country/us/en/wwcontact.html
http://welcome.hp.com/country/us/en/contact_us.html
http://www.hp.com/
http://welcome.hp.com/country/us/en/wwcontact.html
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